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3D Spectrum Application

4.1 Window Layout
4.2 Menu Bar (3D Spectrum Application)
4.3 [3D Spectrum Mesurement Parameters] Window
4.4 Graph View

4.1 Window Layout
The 3D spectrum application has two modes consisting of "measurement mode" and "view mode".
Clicking [Measurement] on the main toolbar changes to measurement mode and clicking [View] changes to view
mode, which is used for offline tasks such as data analysis.
To edit 3D spectrum report files or print using any created layout, click [Edit Printform] on the toolbar.

■Measurement mode

Window Layout of the 3D Spectrum Application (Measurement Mode)

No.

Name

3D spectrum
measurement
toolbar

Function
The buttons used for starting and stopping measurement and performing
instrument control are located on this toolbar.
Clicking
enables

Photometer status

([Connect]) and establishing a connection with the instrument
([Start]) and other buttons.

The upper section displays the current wavelength and fluorescence intensity and
the lower section displays the status of the spectrofluorophotometer.
"2.7 Photometer Status"

Displays the settings of the currently configured measurement parameters (settings
such as parameters related to measurement and whether to perform automatic
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Parameter view

printing).
This view is used to configure and save measurement parameters and load
measurement parameter files.
"2.8 Parameter View"

Graph view

Displays a spectrum graph and 3D spectrum contour plot in real time during
measurement.

■View mode

Window Layout of the 3D Spectrum Application (View Mode)

No.

Name

Parameter view

Function
Displays measurement parameter information, data history, and summary
information (such as sample information and instrument information) of the active
data.
"2.8 Parameter View"

Graph view

[Active]

Select the display method for the graph view.
Displays a 3D spectrum graph of the active data and a 2D spectrum graph
corresponding to the cursor position or a graph of changes in fluorescence intensity
over time.
"Contour Plot" or "3D Spectrum Graph" can be selected as the display format of
the 3D graph.
"4.2.4 [3D Graph] Menu"

[Tile]

Displays intensity contours of multiple 3D spectra in tiled form.

■Edit print form
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Window Layout of the 3D Spectrum Application (Edit Print Form)

No.

Name

Function

Print form editing
area

Edit properties such as position and size of printable objects placed on a report.

Properties view

Displays the properties of printable objects selected in the print form editing area.
Properties such as link settings and text font can be changed.

Printable objects

Displays the printable objects that can be used in tree format.
Either double-click on object names or drag object names into the print form
editing area to add printable objects to a report file.
"9.3 Printable Objects"

4.2 Menu Bar (3D Spectrum Application)
l
l
l
l
l
l
l
l

4.2.1 [File] Menu
4.2.2 [Edit] Menu
4.2.3 [View] Menu
4.2.4 [3D Graph] Menu
4.2.5 [Instrument] Menu
4.2.6 [Tools] Menu
4.2.7 [Window] Menu
4.2.8 [Help] Menu

4.2.1 [File] Menu
Command
[Open]

Description
Open a saved file.
"1.2 File Types"

[Data]
[Parameters]

Open a 3D spectrum data file (.fs3f).
Open a 3D spectrum measurement parameter file (.fm3s).
This type of file can also be opened with [Load] in the parameter view.
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Close the data file that contains the active data set.

[Close]

A save confirmation message is displayed if the target data file is unsaved.

[Close All]

Close all currently open data files.

[Save]

Save the data file that contains the active data set by overwriting.

[Save As]

Specify a filename and save a data file or measurement parameter file.

[Data]

Save a data file (.fs3f). The file targeted for saving is the data file that contains the
active data set.

[Parameters]

Save the settings configured in the parameter view of the measurement mode window
to a measurement method file (.fm3f).

[Data Table]

Save the data processing result table for data print, point pick, peak pick, area
calculation, or batch point pick in the data processing view to a text file (.txt).

[Save All]

Save all unsaved data files that are open by overwriting.
Display the [Arrangement of Data] window. Set the direction to arrange X-axis
(fluorescence wavelength) 3D spectrum data and click [OK] to save a text file.

[Text File Output]

[Arrangement of Data] Window

The format and conversion conditions for text file output are set via [User Setting] on
the [Tools] menu.
"[User Setting] window (common)"

[Extract Spectrum]

Save the spectrum data displayed in the middle section of the graph view to a
spectrum file (.fs3s).

(Recent File)

The three most recently used files are displayed.

[Properties]

Display the [File Properties] window. This window is used to check data information
and perform operations such as renaming data sets.
"[File Properties] window"

[Print Preview]

Display a preview of printer output.
Print the report file linked to the currently active view.

[Print]

"[Quick Print] tab"

[Exit]

Exit the 3D spectrum application and close the window.

4.2.2 [Edit] Menu
"2.2.1 [Edit] Menu"

4.2.3 [View] Menu
"2.2.2 [View] Menu"

4.2.4 [3D Graph] Menu
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Measurement mode
Command

Description
Display the [Customize 3D Graph] window. This window is used to set the display
conditions for 3D graphs.

[Customize]

"[Customize 3D Graph] window"

View mode
Command
[Active]/[Tile]

Description
Switch between the [Active] tab or [Tile] tab of the 3D graph view.
Switch between [3D Spectrum Graph] display format or [Contour Plot] display format
for the 3D graph.

[3D Spectrum
Graph]/[Contour Plot]

• [3D Spectrum Graph]: Display a 3D view of 2D spectrum waveforms arranged
along the depth axis direction.
• [Contour Plot]: Display the fluorescence intensity distribution using color
gradation.
Set the division method used on the tile tab. This divides the area for displaying
contour plot into the selected number and layout (number in horizontal and vertical
directions).
Selection options: 1´2, 2´1, 2´2, 2´3, 3´2

[Tile Layout]

Set the display conditions of the 3D graph in the [Customize 3D Graph] window.

[Customize]

"[Customize 3D Graph] window"

■[Customize 3D Graph] window

[Customize 3D Graph] Window

No.

Item
[Show Color Bar]

Description
Display or hide the color bar that indicates the intensity axis of the contour plot.
Specify the display color of the contour plot.

[Monochrome]/
[Color]

• [Monochrome]: Display in grayscale using the specified number of gradations.
• [Color]: Display using the number of colors set for [Gradation].

[Gradation]

Select the number of grayscale or color gradations to use for the contour plot.
Selection options: 8, 16, 32, 64, 128, 256 (default: 32)
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[Limit (Intensity)]

Set the display method of the fluorescence intensity axis scale for contour plot.

[Auto Scale
(Drawing
Range)]

Set an intensity axis that shows the maximum to minimum of the data in the
displayed range.

[Auto Scale
(Full Range)]

Set an intensity axis that shows the maximum to minimum of the data range on the
graph.

[Fixed]

Display an intensity axis using user defined maximum and minimum limits.

[Number of
Spectrum]

Set the amount of spectrum data to display for 3D spectrum graph.
Selection options: 10, 20, 30, 40, 50, 100 (default: 100)

[OK]

Close the [Customize 3D Graph] window and redisplay the graph view based on
the settings.

[Cancel]

Cancel any settings made and close the [Customize 3D Graph] window.

4.2.5 [Instrument] Menu
"2.2.3 [Instrument] Menu"

4.2.6 [Tools] Menu
"2.2.4 [Tools] Menu"

■[User Setting] window (3D spectrum application)
The settings on the [Text File Formats] , [Text Output], and [PDF Output] (Option) tabs are the same for all of the
basic analysis applications.
"[User Setting] window (common)"

[General] tab

[User Setting] Window - [General] Tab

Item

Description

[Show Messages]

Select whether to display confirmation messages.

[Number of Displayed
Decimal Places]

Set the number of decimal places to show for displayed numerical data, such as graph
scale values and for data printing.

[X-Axis Value]

Select the number of decimal places for X-axis values.
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Selection options: 0, 1
[Y-Axis Value]

[Data Display Format]

Select the number of decimal places for Y-axis values.
Selection options: 0 to 3
Select the format of data set names for printing and display in the data processing
table.
Display formats that can be selected include "full path name" and "data set name
only".
Select this checkbox to display [RawData] (data before spectrum correction).

[Show RawData]

This setting is available when connecting to the RF-6000 series.

[Quick Print] tab

[User Setting] Window - [Quick Print] Tab

Item

Description
Displays the views and data tables that can be linked to report files.

[Print Item]

• For the [Tile] tab, report files can be selected according to the state of the
division settings.
• The parameter view of the [View] menu is shown.

[Report File]

Clicking an item in the [Print Item] list selects it and displays the name and save
destination of the report file to which it is linked.

[Browse]

Display the report file selection window.

[Reset]

Return links to their initial state.

[Links] tab
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[User Setting] Window - [Links] Tab

Item

[Link Description]

Description
Displays link items (active, tile number on tile tab, etc.) for setting to reports.
For details on tile numbers, see "Edit Print Form".
"Link items (3D spectrum application)" in "9 Editing Print Forms"

Displays the data sets corresponding to the [Link Description] items. For example,
when quick printing a report that contains a graph object set with "Tile tab Tile1", this
column allows you to check which data set graph will be printed.

[Data Set]

4.2.7 [Window] Menu
"2.2.5 [Window] Menu"

4.2.8 [Help] Menu
"2.2.6 [Help] Menu"

4.3 [3D Spectrum Mesurement Parameters] Window
■[Measurement] tab
There is a restriction of 100,000 data points for the maximum number that can be captured and saved as 3D
spectrum data. A message is displayed if a value exceeding this maximum is set. The window cannot be closed
until a value less than the maximum is entered.
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[3D Spectrum Mesurement Parameters] Window - [Measurement] Tab

Item

Description
Select the spectrum type.
• [Emission]: Repeatedly measure in the specified fluorescence wavelength range
while keeping the excitation wavelength fixed.
• [Excitation]: Repeatedly measure in the specified excitation wavelength range
while keeping the fluorescence wavelength fixed.

[Spectrum Type]

• [Synchronous]: Repeatedly measure in the specified ranges while moving the
excitation wavelength and fluorescence wavelength.
• [3D]: Measure the fluorescence spectrum while setting the excitation wavelength
at the specified interval.
In synchronized scanning, the excitation wavelength moves by the same
wavelength width as for the fluorescence wavelength scan range.
For example, when the start wavelength is set to 400 nm on the excitation side
and the scan range on the emission side is set to 500 to 800 nm, the excitation
wavelength measurement range is 400 to 700 nm (the data interval is the same
as that set for the emission side).

[Excitation]/
[Emission]

Set the wavelength to measure, wavelength range, and data interval.

[Wavelength]

Enter the wavelength to measure.
Effective range: 220 to 900 (RF-5300 series), 200 to 900 (RF-6000 series)

[Start]/
[End]

Enter the wavelengths to measure.
Effective range: 220 to 900 (RF-5300 series), 200 to 900 (RF-6000 series)
Select a data interval. Selection options differ depending on the instrument model and
configured scan speed.

[Data Interval]

[Repetitions]

"3.3.1 Scan Speed and Data Interval"
When [3D Spectrum] is selected for [Spectrum Type], a maximum of 301
fluorescence spectrum can be captured.
Set a large data interval for the excitation wavelength if the excitation
wavelength range is wide.

This setting is enabled when [Emission], [Excitation], and [Synchronous] is selected
as the spectrum type.

[Number of Times
(times)]

Enter the number of times to repeat spectrum measurement.
Effective range: 2 to 100 (integer)

[Interval (second)]

Enter the interval at which to repeat spectrum measurement.
Effective range: 2 to 9999 (integer)
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Select the scan speed. Selection options differ depending on the instrument model.
"3.3.1 Scan Speed and Data Interval"

Select this checkbox to perform printing automatically after measurement using the
specified report file.
Enter the full path of the report file to use for automatic printing. The report file can
also be selected by clicking
.
This field is enabled when the [Perform Auto Print] checkbox is selected.

[Save As]

Save the settings as a measurement parameters file.

[OK]

Confirm the settings made and close the [3D Spectrum Mesurement Parameters]
window.

[Cancel]

Cancel the settings made and close the [3D Spectrum Mesurement Parameters]
window.

■[Instrument] tab
"[Instrument] tab"

■[Attachment] tab
"[Attachment] tab"

4.4 Graph View
Information displayed in the graph view differs for the measurement mode and view mode.
l
l

4.4.1 Measurement Mode
4.4.2 View Mode

4.4.1 Measurement Mode
In this mode, a 3D intensity contour is shown in the upper section of the data area and a spectrum graph is shown
in the lower section.
During measurement, the spectrum data captured from the instrument is drawn on the graph in the lower section
in real time, and when one complete spectrum data set is captured, the result is updated to the 3D graph in the
upper section.
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Graph View (Measurement Mode)

■3D graph right-click menu
Click the right mouse button on the 3D graph to display the following right-click menu.
Command
[Copy]

Description
Copy the graph on the [3D] tab to the clipboard.

[Picture]
[Auto Scale]

Save a graph image in metafile format to the clipboard.
Perform automatic scaling of the 3D graph.
Set the display range of wavelengths and the time axis scale on the 3D graph.

[3D Graph Scale]

[Vertical axis]

Select [Linear] or [Logarithmic] for the vertical axis of the graph.

■Right-click menu of the transverse section graph (measurement mode)
Click the right mouse button on the graph to display the following right-click menu.
Command
[Copy]
[Picture]

Description
Copy the graph on the [Active] tab to the clipboard.
Save a graph image in metafile format to the clipboard.
The graph can be pasted as an embedded graph object in report editing mode.

[For Report File]

An embedded graph object is an object that is not linked to the graph view
state.

Perform automatic scaling of the graph. Automatic scaling conditions are configured
on the [Limits] tab in the [Customize Graph] window.
[Auto Scale]

"[Limits] tab" in "3.2.4 [Graph] Menu"
Double-clicking on the graph will also perform automatic scaling.

[Cursor]

Select the cursor type to display on the graph.

[None]

A normal cursor is displayed (default).

[Crosshairs]

Displays a cursor with an intersecting vertical and horizontal line. The intersecting
point is moved in the graph view using the mouse and the coordinates are displayed
on both scales.
Configure settings such as graph line type, line color, background color, and scale
font.

[Customize]

The line type and line color settings are valid only at the time of
change. Settings will be reset if the cursor on the 3D graph is
moved to change the displayed spectrum portion.
"3.2.4 [Graph] Menu"

[Vertical axis]

Select [Linear] or [Logarithmic] for the vertical axis of the graph.

[Properties]

Display the graph properties window. This window allows a line to be drawn at the
zero point of fluorescence intensity on the graph.
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4.4.2 View Mode
The available graph views in view mode are the [Active] and [Tile] tabs. The graph view displayed on the
[Active] tab differs depending on the 3D graph display format (Contour plot or 3D spectrum graph).

■[Active] tab/3D Spectrum Graph
Graph display is divided into two sections.
• Upper section: Displays a 3D spectrum graph of the active data set. (3D graph)
• Lower section: Displays the spectrum data at the cursor position (X axis) in the 3D graph view. (Horizontal
section graph)
Dragging up, down, left, or right on the 3D graph while holding down the right mouse button rotates the 3D spectrum
graph.

Data Area (View Mode) - [Active] Tab

No.

Item

3D graph
(3D spectrum
graph)

Description
Displays the active data set in 3D spectrum graph format.
Dragging up, down, left, or right on the 3D graph while holding down the right
mouse button rotates the graph.
Set the number of spectra to display via [Customize 3D Graph] on the [3D Graph]
menu.
"[Customize 3D Graph] window"

Graph axes

Indicates the axes of the 3D spectrum graph and their directions.
This mark rotates with the graph.

Cross-hair cursor

When the mouse cursor is moved into the 3D spectrum graph, a cross-hair cursor
is displayed at the bottom of the graph and moves along with the mouse.
The spectrum at the cursor position (transverse section) is displayed at , and the
coordinates of the cross-hair center are displayed at .
Click to lock the cross-hair cursor in place and click again to release it.

Coordinates

Displays the coordinates (horizontal axis / depth axis / intensity) of the cross-hair
cursor center.

Setting of
transverse
sectioning position

Enter the excitation wavelength or time in the field and click [Perform]. The
spectrum data of the specified position is displayed at .

Feed buttons

After locking the cross-hair cursor or directly setting a spectrum at , click these
buttons to move the spectrum extraction position in increments of the data interval.
The 2D graph is redrawn.
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Displays the spectrum at the wavelength or time set using

,

and

.

3D graph right-click menu
"3D graph right-click menu"

Right-click menu of the transverse section graph (view mode)
Click the right mouse button on the graph to display the following right-click menu.
Command
[Copy]
[Picture]

Description
Copy the graph on the [Active] tab to the clipboard.
Save a graph image in metafile format to the clipboard.
The graph can be pasted as an embedded graph object in report editing mode.

[For Report Item]

An embedded graph object is an object that is not linked to the graph view
state.

Perform automatic scaling of the graph. Automatic scaling conditions are configured
on the [Limits] tab in the [Customize Graph] window.
[Auto Scale]

"[Limits] tab" in "[Customize Graph] window"
Double-clicking on the graph will also perform automatic scaling.

[Cursor]

Select the cursor type to display on the graph.

[None]

A normal cursor is displayed (default).

[Crosshairs]

Displays a cursor with an intersecting vertical and horizontal line. The intersecting
point is moved in the graph view using the mouse and the coordinates are displayed
on both scales.

[Surfing]

Displays a cursor with an intersecting vertical and horizontal line. The intersecting
point is moved across the active graph using the mouse and the coordinates are
displayed on both scales.

[Lock Cursor]

Fix the position of the cursor in the graph.

[Extract Spectrum]

Save the displayed waveform data as a spectrum data file (.fs2f).
Configure settings such as graph line type, line color, background color, and scale
font.

[Customize]

The line type and line color settings are valid only at the time of
change.
Settings will be reset if the cursor on the 3D graph is moved to
change the displayed spectrum portion.
"[Customize Graph] window"

[Vertical axis]

Select [Linear] or [Logarithmic] for the vertical axis of the graph.

[Text File Output]

Save the displayed waveform data as a text file (.txt) or CSV file (.csv).
The format and conversion conditions for text file output are set via [User Setting] on
the [Tools] menu.
"[User Setting] window (common)"

[Print]

Perform a quick print.
Set the report file to use via [User Setting] on the [Tools] menu.
"[Quick Print] tab"

[Properties]

Display the graph properties window. This window allows a line to be drawn at the
zero point of fluorescence intensity on the graph.

■[Active] tab/Contour Plot
Graph display is divided into three sections.
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• Upper section: Displays the active data set as Contour Plot. (3D graph)
• Middle section: Displays the spectrum data corresponding to the horizontal cursor position in the 3D graph
view. (Horizontal section graph)
• Lower section: Displays the waveform data segmented from the vertical cursor position in the 3D graph view.
(Vertical section graph)

Data Area (View Mode) - [Active] Tab

No.

Item

Description

3D graph
(intensity contour)

Displays the active data set as an intensity contour.

Distribution axes

The axes of the intensity contour are indicated in “horizontal axis / vertical axis”
format.

Color bar

Displays the intensity axis scale in a color gradation.
Show or hide the color bar via [Customize 3D Graph] on the [3D Graph] menu.
"[Customize 3D Graph] window"

Cross-hair cursor

Move the mouse cursor into the intensity contour. A cross-hair cursor will move
according to the mouse.
The spectrum at the horizontal cursor position (transverse section) is displayed at
and the waveform at the vertical cursor position (longitudinal section) is
displayed at .
The coordinates of the cross-hair cursor center are displayed at .
Double-click to lock the cross-hair cursor in place and click to release it.

Coordinates

Displays the coordinates (horizontal axis / vertical axis / intensity) of the cross-hair
cursor center.

Setting of
transverse
sectioning position

Enter the excitation wavelength or time in the field and click [Execute]. The
spectrum data of the specified position is displayed at .

Feed buttons

After locking the cross-hair cursor or directly setting a sectioning position at /
, click these buttons to move the sectioning position in increments of the data
interval. The 2D graph is redrawn.

Transverse section
graph

Displays the spectrum at the wavelength or time set using

Setting of
longitudinal
sectioning position

Enter the wavelength (longitudinal sectioning position) in the field and click
[Execute]. The waveform of the specified position is displayed at .
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Longitudinal
section graph

Displays the spectrum at the wavelength (longitudinal sectioning position) set
using ,
and .

3D graph right-click menu
"3D graph right-click menu"

Right-click menu of Horizontal section graph (View mode)
"Right-click menu of the transverse section graph (view mode)"

Right-click menu of vertical section graph
The right-click menu is the same as displayed on the graph view of the spectrum basic analysis application.
The line type and line color settings made at [Graph Setting] for a longitudinal section graph are
valid only at the time of change.
Settings will be reset if the cursor on the 3D graph is moved to change the displayed spectrum
portion.
"Right-click menu of the graph view (view mode)"

■[Tile] tab
The [Tile] tab is divided into multiple 3D graph areas. Contour plot graphs can be displayed in tiled form for
comparison. Dragging any 3D spectrum data set from the tree view into the 3D graph area displays an contour
plot graph.
Configure the division settings by selecting [Tile Layout] on the [3D Graph] menu.
"4.2.4 [3D Graph] Menu"

3D Spectrum Graph cannot be selected as the 3D graph display format.

Data Area (View Mode) - [Active] Tab

No.

項目
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Displays the data set name of the displayed intensity contour.
The display format of data set names can be changed in the [User Setting] [General] tab on the [Tools] menu.
"[User Setting] window (3D spectrum application)"

Cross-hair cursor

Move the mouse cursor into the intensity contour. A cross-hair cursor will move
according to the mouse.
The coordinates of the cross-hair cursor center are displayed at .
Click to lock the cross-hair cursor in place and click again to release it.

Coordinates

Displays the coordinates (horizontal axis / vertical axis / intensity) of the cross-hair
cursor center.

Red frame (scale
reference)

A red frame is displayed around the tile if [Lock Cursor] is selected from the rightclick menu.

Distribution axes

The axes of the intensity contour are indicated in “horizontal axis / vertical axis”
format.

Color bar

Displays the intensity axis scale in a color gradation.
Show or hide the color bar via [Customize 3D Graph] on the [3D Graph] menu.
"[Customize 3D Graph] window"

Right-click menu of 3D graph (tile)
Click the right mouse button on the 3D graph to display the following right-click menu.
Command
[Copy]
[Picture]

Description
Copy the graph in the selected area (area clicked with the right mouse button) to the
clipboard.
Save a graph image in metafile format to the clipboard.

[Auto Scale]

Perform automatic scaling of the 3D graph.

[3D Graph Range]

Set the display range of wavelengths and the time axis scale on the 3D graph.

[Vertical axis]

Select [Linear] or [Logarithmic] for the vertical axis of the graph.

[Lock Cursor]

Sets the graph scale of the selected tile as the reference scale for linked graphs. A red
frame encloses the area specified as the reference. Click (adding/removing a check
mark) on the menu to select or deselect as the reference scale.

[Linkage scale]

Links and redraws the intensity contour to the graph scale of the specified reference
tile.
Click (adding/removing a check mark) on the menu to link or unlink.
This command becomes enabled by specifying a desired graph on the tile tab as
reference (by clicking the [Lock Cursor] menu to check it).

[Clear]

Clear the 3D graph display of the selected area.
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